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Disclaimer

Alderman & Company Capital, LLC, is a Connecticut limited liability company that is a 
broker-dealer registered with the Securities and Exchange Commission and a member 
of the Financial Regulatory Authority (FINRA). Alderman & Company Capital, LLC, is 
also a member of the Securities Investors Protection Corporation (SIPC).  Alderman & 
Company Capital, LLC, provides investment banking, private placement, merger, 
acquisition divestiture and other securities related services.  The material contained in 
this presentation is for general informational purposes only. The material contained 
herein is not to be construed as an offer or a recommendation to buy or sell a security 
nor is it to be construed as investment advice. Additionally, the material in this 
presentation does not constitute a representation that any investments described 
herein are suitable or appropriate for any person. Alderman & Company Capital, LLC, 
gathered the data from sources considered reliable; however, there is no guarantee as 
to the accuracy or completeness of the information provided within this publication. 
The material presented reflects information known to the Alderman & Company 
Capital, LLC, at the time this publication was written, and this information is subject to 
change. No warranties, expressed or implied are made, regarding the accuracy of this 
material. Officers, directors and members of Alderman & Company Capital, LLC, or its 
affiliates may have positions in the securities of the companies discussed during this 
presentation. This presentation does not constitute a recommendation with respect to 
any securities of any company that might be discussed herein, is not intended to 
provide information upon which to base an investment decision, and should not be 
construed as such. Alderman & Company Capital, LLC, or its affiliates may from time
to time provide investment banking or related services to companies that may be 
mentioned during this presentation. The authors of this publication receive 
compensation that is affected by overall firm profitability. 
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What is financial excellence?

“Financial excellence” is having the 
processes in place to confidently make, 
on a timely basis, informed decisions 
regarding matters that significantly 
impact the cash-flow of your business
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Why achieve financial excellence?

1) To be able to quantify risks
• What would happen if we ship 15% less than 

forecast in the second-half of 2009?

• What would happen if there is a 2% decrease in 
pricing 2009?

• At what level of deferrals in 2010 would we start 
to have difficulty making loan payments to the 
bank? 

To quantify the impact on cash flow
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Why achieve financial excellence?

2) To be able to quantify opportunities
• We have an opportunity to acquire a used piece 

of equipment at a great price.  Should we do it? 
• If we pay for the NRE on a new assembly, we 

will get a 5-year exclusive.  Should we do it?
• Prices on a key commodity for us is at a 6-year 

low.  Should we overstock?
• A trusted vendor just made us a very attractive 

offer to take-over some processes that we 
currently do in-house.  Should we outsource this 
process?

To quantify the impact on cash flow
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Why achieve financial excellence?

3) To be able to set clear expectations
• Executive compensation

• Employee compensation

• Creditors (covenants & repayments)

• Shareholders (earnings, distributions, returns)

• Other stakeholders (governments, etc)

Most privately held aerospace companies do not 
hold managers accountable for cash flow targets
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Why achieve financial excellence?

3) Setting expectations - Continued 

Examples:
• We plan to distribute $1.8 million to our 

shareholders in 2009

• Senior management will receive 35% bonuses if 
net cash-flow meets or exceeds $4.25 million

• We will reduce our line of credit borrowings by 
$2.5 million by year-end
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How to achieve financial excellence
Four steps to financial excellence:

1. Data capture

2. Financial planning

3. Financial analysis

4. Making informed decisions

Much of this is addressed in the SEA Roadmap
(Ref. 1.1.3 – balanced scorecard)
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How to achieve financial excellence

1. Data capture
• You can’t manage “it” if you don’t measure “it”

(just like 6σ)

• What is it?
“It” is your CASH - all aspects of your business 
that consume or generate cash. Note: there are 
very few aspects of any business that don’t 
generate or use cash.

Financial excellence requires the capture of real time 
data regarding all activities that impact cash
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How to achieve financial excellence

1. Data capture - continued

Establish processes to capture real time data 
► This is usually the most difficult part of 

achieving financial excellence
► Timeliness:  The closer to real time the 

better, but old data is better than no data
► Accuracy: 100% reliability is better, but data 

with estimates is better than no data

The more accurate the data, the greater the confidence 
you will have when you make decisions
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How to achieve financial excellence

2. Financial planning (budgeting)
• Periodicity

►Monthly (12x) 
►Yearly (3x)

• Format
►Must include all aspects of the business that 

can impact (generate or consume) cash

Financial plans should include all factors that 
impact cash flow



16

How to achieve financial excellence

2. Financial planning - continued

There are numerous COTS planning programs

– Alight Planning Software www.alightplanning.com

– Budget Maestro  www.centage.com

– Cash Flow XT2-2009 www.cashplan.com

– Ultimate Financial Forecaster 3.0 www.abs-usa.com

– Whitebirch Planning www.projectedfinancials.com

The above are a random sample of COTS financial planning software programs.  There are many others.  
Alderman & Company Capital, LLC has no relationship with the above companies and does not support or 
recommend these programs.  These have been provided only for example purposes.
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How to achieve financial excellence
2. Financial planning – Continued

• Strike a reasonable balance between cost to 
implement and quality of data

• Don’t try to make your plans ‘100% accurate’, no one 
can predict the future perfectly

• If you spend too much time generating your budgets, 
you will stop doing them

Sound financial planning facilitates
better decision making
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How to achieve financial excellence

Production
Plan

Production
Plan

Sales 
Plan

Sales 
Plan

Strategic
Plan

Strategic
Plan

Financial
Plan

Financial
Plan

The financial plan links all other corporate plans

2. Financial planning
– Continued
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How to achieve financial excellence

3. Financial analysis  (variance to plan)
• Periodicity

► Weekly – Level 1 Data
► Monthly – Level 1 and 2 Data
► Quarterly – All Data

• Organization 
► Who runs the meetings?
► Who attends the meetings?
► What information is ‘not shared’

Analysis identifies risks and opportunities
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How to achieve financial excellence

3. Financial analysis - continued
Financial analysis should be tailored to the unique 
attributes of your business

► What are the Level 1, 2 and 3 financial metrics 
for your business? 

► How can your organization do financial analysis 
efficiently? 

► Should/can financial analysis become a part of 
your corporate culture?
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How to achieve financial excellence
4. Making informed decisions

Through financial excellence, management gains better 
insight into risks and opportunities facing the business 
and greater confidence to act quickly and decisively

Examples:
► Inventory is $1.2MM over plan

– What caused this?
– What should we do in response? 

► A customer pushed-out $5MM in work by 26 weeks
– What does this mean to our Op Plan?
– Does this impact our ability to make the loan payment 

coming due in 8-months? 

Financial Excellence empowers management to act 
faster and with greater confidence
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Example

Example:
Financial Planning Model

[Financial Modeling Scenarios]
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Sample Corporation
Financial Model
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Sample Corporation Model 3/12/2009 8:04 AM

SUMMARY Historical Historical Historical 3 Year Projected Projected Projected Projected Projected
($000) 12/31/06 12/31/07 12/31/08 Average 12/31/09 12/31/10 12/31/11 12/31/12 12/31/13
Revenue 45,000       50,000       55,000      50,000     57,750     60,638      63,669     66,853     70,195     
  Growth 11% 10% 5% 5% 5% 5% 5%

Gross Profit 15,000 16,500 17,500 16,333     18,375 19,294 20,258 21,271 22,335
 As % Rev. 33% 33% 32% 33% 32% 32% 32% 32% 32%

SG&A 9,000 9,500 10,000 9,500       10,500 11,025 11,576 12,155 12,763
 As % Rev. 20% 19% 18% 19% 18% 18% 18% 18% 18%

EBITDA 6,300 7,325 7,875 7,167       7,575 7,919 8,307 8,716 9,122
 As % Rev. 14% 15% 14% 14% 13% 13% 13% 13% 13%
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Sample Corporation Model 3/12/2009 8:04 AM

BALANCE SHEETS 
($000) Historical Historical Historical Historical Historical Historical

12/31/06 12/31/07 12/31/08 12/31/06 12/31/07 12/31/08
ASSETS LIABILITIES
Cash & Mkt Sec. 500 650 750 Current Portion of LT Debt 500 550 650
Accounts Receivable 6,000 6,500 6,750 Short Term Borrowings 1,000 1,000 1,000
Inventory 15,000 15,500 16,000 Accounts Payable 5,000 5,250 5,500
Other 0 0 0 Accrued Expenses 1,200 1,300 1,400
Prepaid Expenses 1,000 1,100 1,200 Customer Deposits 0 0 0
Other 0 0 0 Other 0 0 0
  Total Current Assets 22,500 23,750 24,700  Total Current Liabilities 7,700 8,100 8,550

Property & Equipment (net) 10,000 12,000 14,000     
Long-term Debt 3,500 3,600 3,700
Other 0 0 0
 Total Other Liabilities 3,500 3,600 3,700

Other Assets 0 0 0 TOTAL LIABILITIES 11,200 11,700 12,250
  Total Other Assets 0 0 0

EQUITY 21,300 24,050 26,450

TOTAL ASSETS 32,500 35,750 38,700     TOTAL LIAB & EQUITY 32,500 35,750 38,700

 

Alderman Proprietary Financial Model for SEA Presentation 03 2009.xls 3 of 13



Sample Corporation Model 3/12/2009 8:04 AM

HISTORICAL P&L
($000) 12/31/06 12/31/07 12/31/08

Net Sales (% Change) 45,000 50,000 11% 55,000 10%
Adjusted Cost of Goods Sold 30,000 33,500 37,500
Gross Profit  (% Sales) 15,000 33% 16,500 33% 17,500 32%

SG&A 9,000 20% 9,500 19% 10,000 18%
Operating Income 6,000 13% 7,000 14% 7,500 14%

Interest (Exp) Inc, Net (250)            (350)              (450)              
Other (Losses) Gains 0 0 0
Other (Exp) Inc 0 0 0
  Total Other Exp (Inc) (250)            (350)              (450)              

Income Before Taxes 5,750          6,650            7,050            
Taxes (2,243) (2,594) (2,750)
Adjusted Net Income 3,507 8% 4,056 8% 4,300 8%

EBITDA
Net Income 3,507 4,056 4,300
Interest Expense 250 350 450
Taxes 2,243 2,594 2,750
Depreciation 300 325 375
  EBITDA 6,300 14% 7,325 15% 7,875 14%
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Sample Corporation Model 3/12/2009 8:04 AM

WORKING CAPITAL
($000, where applicable) Historical Historical Historical Projected Projected Projected Projected Projected

12/31/2006 12/31/2007 12/31/2008 Hist. Avg. 12/31/2009 12/31/2010 12/31/2011 12/31/2012 12/31/2013
Accounts Receivable
Avg. Days Outstanding 49 47 45 47 47 47 47 47 47
Total Revenue 45,000 50,000 55,000 57,750 60,638 63,669 66,853 70,195
Receivables 6,000 6,500 6,750 7,432 7,803 8,193 8,603 9,033

Owned Inventory
Avg. Days Outstanding 183 169 156 169 169 169 169 169 169
Cost of Good Sold 30,000 33,500 37,500 39,375 41,344 43,411 45,581 47,861
Inventory 15,000 15,500 16,000 18,235 19,147 20,104 21,110 22,165

Prepaid & Other Current Assets
Total Revenue 45,000 50,000 55,000 57,750 60,638 63,669 66,853 70,195
% of Revenue 2.22% 2.20% 2.18% 2.20% 2.20% 2.20% 2.20% 2.20% 2.20%
Prepaid & Other 1,000 1,100 1,200 1,271 1,335 1,402 1,472 1,545

Accounts Payable 
Avg. Days Outstanding 61 57 54 57 57 57 57 57 57
Cost of Good Sold 30,000 33,500 37,500 39,375 41,344 43,411 45,581 47,861
Accounts Payable 5,000 5,250 5,500 6,169 6,478 6,802 7,142 7,499

Accrued Expenses
Total Revenue 45,000 50,000 55,000 57,750 60,638 63,669 66,853 70,195
% of Revenue 2.67% 2.60% 2.55% 2.60% 2.60% 2.60% 2.60% 2.60% 2.60%
Accrued Expenses 1,200 1,300 1,400 1,504 1,579 1,658 1,741 1,828

Total Working Capital 15,800 16,550 17,050 19,265 20,228 21,240 22,302 23,417
Change in Working Capital 750 500 2,215 963 1,011 1,062 1,115

HISTORICAL WORKING CAPITAL PROJECTED WORKING CAPITAL
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Sample Corporation Model 3/12/2009 8:04 AM

CAP-X Projected Projected Projected Projected Projected
($000) 12/31/2009 12/31/2010 12/31/2011 12/31/2012 12/31/2013

Project 1 25              35              75              -                 -                 
Project 2 50              75              15              -                 -                 
Project 3 100            500            100            50              -                 
Project 4 -                 35              65              25              -                 
Project 5 -                 100            200            25              25              
Project 6 -                 50              50              50              -                 
Project 7 -                 -                 250            -                 -                 
Project 8 -                 -                 -                 200            -                 
Project 9 -                 -                 -                 -                 75              
Project 10 -                 -                 -                 -                 -                 
Total 175            795            755            350            100            
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Sample Corporation Model 3/12/2009 8:04 AM

($000) Historical Projected Projected Projected Projected Projected
12/31/2008 12/31/2009 12/31/2010 12/31/2011 12/31/2012 12/31/2013

Sales 55,000 57,750 60,638 63,669 66,853 70,195
5% 5% 5% 5% 5%

Cost of Goods Sold 37,500 39,375 41,344 43,411 45,581 47,861
Gross Profit 17,500 18,375 19,294 20,258 21,271 22,335

32% 32% 32% 32% 32% 32%

Operating Expenses 10,000 10,500 11,025 11,576 12,155 12,763 #
18% 18% 18% 18% 18% 18%

Operating Income 7,500 7,875 8,269 8,682 9,116 9,572
14% 14% 14% 14% 14% 14%

Other
Interest (Exp) Inc, Net (450)           (321) (287) (228) (169) (110)
Other (Losses) Gains -             0 0 0 0 0

Total Other (450) (321) (287) (228) (169) (110)

Taxes (2,750) (3,314) (3,473) (3,621) (3,777) (3,951)
Net Income 4,300 4,240 4,508 4,833 5,170 5,511

EBITDA
Net Income 4,300 4,240 4,508 4,833 5,170 5,511
Interest Expense 450 321 287 228 169 110
Income Taxes 2,750 3,314 3,473 3,621 3,777 3,951
Depreciation & Amort. 375 -300 -350 -375 -400 -450
 EBITDA 7,875 7,575 7,919 8,307 8,716 9,122

14% 13% 13% 13% 13% 13%

PROJECTED INCOME STATEMENTS
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Sample Corporation Model 3/12/2009 8:04 AM

PROJ. CASH FLOW Projected Projected Projected Projected Projected
($000) 12/31/2009 12/31/2010 12/31/2011 12/31/2012 12/31/2013
Opening Cash Balance 750 1,000 1,000 1,000 1,000
EBITDA 7,575 7,919 8,307 8,716 9,122
Working Capital Sources/(Uses) (2,215) (963) (1,011) (1,062) (1,115)
CapX (175) (795) (755) (350) (100)
Cash Available from Operations 5,935 7,161 7,541 8,304 8,907

Cash Taxes (3,314) (3,473) (3,621) (3,777) (3,951)
Interest Expense (321) (287) (228) (169) (110)
Revolver Borrowings/(Repayments 0 0 0 0 0
Debt Borrowings/(Repayments) (740) (740) (740) (740) (740)

(4,375) (4,501) (4,589) (4,686) (4,801)

Cash Available for Distribution 1,560 2,660 2,952 3,618 4,106
Distributions to Shareholders (560) (1,660) (1,952) (2,618) (3,106)
Ending Cash 1,000 1,000 1,000 1,000 1,000

Target Cash Balance 1,000 1,000 1,000 1,000 1,000
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Sample Corporation Model 3/12/2009 8:04 AM

Proj. Bal Sheets Historical Projected Projected Projected Projected Projected
($000) 12/31/2008 12/31/2009 12/31/2010 12/31/2011 12/31/2012 12/31/2013

Assets
Cash & Mkt Sec. 750 1,000 1,000 1,000 1,000 1,000
Accounts receivable 6,750 7,432 7,803 8,193 8,603 9,033
Inventory 16,000 18,235 19,147 20,104 21,110 22,165
Other 0 0 0 0 0 0
Prepaid Expenses 1,200 1,271 1,335 1,402 1,472 1,545
  Total Current Assets 24,700 27,938 29,285 30,699 32,184 33,744

PP&E 14,175 14,970 15,725 16,075 16,175
Accumulated depreciation 300 650 1,025 1,425 1,875
  Net PP&E 14,000 14,475 15,620 16,750 17,500 18,050

Goodwill 0 0 0 0 0 0
Due from Affiliates 0 0 0 0 0 0
Other Assets 0 0 0 0 0 0
Intangible Assets 0 0 0 0 0 0
  Other Assets 0 0 0 0 0 0

TOTAL ASSETS 38,700 42,413 44,905 47,449 49,684 51,794

Historical Projected Projected Projected Projected Projected
12/31/2008 12/31/2009 12/31/2010 12/31/2011 12/31/2012 12/31/2013

Current Portion of LT Debt 650 650 650 650 650 650
Short Term Borrowings 1,000 1,000 1,000 1,000 1,000 1,000
Accounts Payable 5,500 6,169 6,478 6,802 7,142 7,499
Accrued Expenses 1,400 1,504 1,579 1,658 1,741 1,828
Customer Deposits 0 0 0 0 0 0
Other 0 0 0 0 0 0
  Total Current Liabilities 8,550 9,323 9,707 10,110 10,533 10,977

Other 0 0 0 0 0 0
Long-term debt 3,700 2,960 2,220 1,480 740 0
Other 0 0 0 0 0 0
Deferred taxes 0 0 0 0 0 0
  Total Long Term Liabilities 3,700 2,960 2,220 1,480 740 0

Total Liabilities 12,250 12,283 11,927 11,590 11,273 10,977

Starting Equity 26,450 30,130 32,978 35,860 38,412
+ Net Income - Distributions 3,680 2,848 2,881 2,552 2,405
Ending Equity 26,450 30,130 32,978 35,860 38,412 40,817

TOTAL LIAB & EQUITY 38,700 42,413 44,905 47,449 49,684 51,794

Balance Sheet Check 0.0 0.0 0.0 0.0 0.0 0.0
Net Debt At Exit 650

LIABILITIES
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Sample Corporation Model 3/12/2009 8:04 AM

DCF VALUATION
    ($000) Valuation Date 6/30/2009

IRR 15.25%

Terminal Multiple 6.00

Free Cash Flow 12/31/2009 12/31/2010 12/31/2011 12/31/2012 12/31/2013
Distributions to Shareholders 560         1,660      1,952       2,618              3,106      

Terminal Value
   EBITDA 9,122

Terminal Multiple 6.00        
54,733       

   Net Debt at Exit 650         
    Terminal Value 54,083

Discounted Values 12/31/2009 12/31/2010 12/31/2011 12/31/2012 12/31/2013
Year 1               2               3               4                       5               
Discount Factors 1.07          1.24          1.43          1.64                  1.90          
Nominal  Cash Flows 560           1,660        1,952        2,618                57,189       
Discounted Free Cash Flow $521 $1,341 $1,368 $1,592 $30,178

Enterprise Value $35,001
- Net Debt at time zero -$4,610
= Value of Common Stock $30,391
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Sample Corporation
Suppporting Schedules
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Sample Corporation Model 3/12/2009 8:04 AM

ASSUMPTIONS ($000)
Depreciation Schedules

MACRS Schedule 999,999 Hardwired
ADR Schedule 999,999 Hardwired
Book Schedule 999,999 Hardwired

Projected Projected Projected Projected Projected
Starting 12/31/09 12/31/10 12/31/11 12/31/12 12/31/13

Tax Depreciation -300 -350 -375 -400 -450
Book Depreciation -300 -350 -375 -400 -450

TAXES 12/31/09 12/31/10 12/31/11 12/31/12 12/31/13

Income Before Dep & Amort 8,196 8,556 8,910 9,285 9,682

BOOK
Book Depreciation -300 -350 -375 -400 -450
Taxable Income 8,496 8,906 9,285 9,685 10,132
Tax Rate 39.0% 39.0% 39.0% 39.0% 39.0%
Book taxes 3,314 3,473 3,621 3,777 3,951

IRS TAXES
IRS Depreciation -300 -350 -375 -400 -450
Other 0 0 0 0 0
Taxable Income 8,496 8,906 9,285 9,685 10,132
Tax Rate 39.0% 39.0% 39.0% 39.0% 39.0%
Cash Taxes 3,314 3,473 3,621 3,777 3,951

Increase (dec.) Deferred Taxes 0 0 0 0 0

DEPRECIATION & TAXES
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Sample Corporation Model 3/12/2009 8:04 AM

($000)

($000) Adjusted Estimated Projected Projected Projected Projected
Long-term Debt 12/31/07 12/31/08 12/31/09 12/31/10 12/31/11 12/31/12
Beginning Balance 3,700 2,960 2,220 1,480 740
Additions 0 0 0 0
Principal Payment 740 740 740 740 740
Ending Balance 3,700 2,960 2,220 1,480 740 0
Months Outstanding 12 12 12 12 12
Interest Expense 241 207 148 89 30
Avg. Interest 7.25% 8.00% 8.00% 8.00% 8.00%

Other 1
Beginning Balance 0 0 0 0 0
Additions 0 0 0 0 0
Principal Payment 0 0 0 0 0
Ending Balance 0 0 0 0 0 0
Months Outstanding 12 12 12 12 12
Interest Expense 0 0 0 0 0
Avg. Interest 8.00% 8.00% 8.00% 8.00% 8.00%

Adjusted
12/31/07 12/31/08 12/31/09 12/31/10 12/31/11 12/31/12

Revolver: Borrowing Base Analysis
Accounts Receivable 6,750 7,432 7,803 8,193 8,603 9,033

 Loan Advance Rate [1] 75% 75% 75% 75% 75% 75%
5,063 5,574 5,852 6,145 6,452 6,775

Inventory 16,000 18,235 19,147 20,104 21,110 22,165
 Loan Advance Rate 50% 50% 50% 50% 50% 50%

8,000 9,118 9,574 10,052 10,555 11,083

Available Base 13,063 14,691 15,426 16,197 17,007 17,857
Beginning of Year Revolver Balance 0 0 1,000 1,000 1,000 1,000
Excess Revolver Availability 13,063 14,691 14,426 15,197 16,007 16,857

Revolving Line of Credit
Beginning Balance 1,000 1,000 1,000 1,000 1,000
New draws as % of Excess Borrowing Availabil 0.0% 0.0% 0.0% 0.0% 0.0%
New Borrowings 0 0 0 0 0
Ending Balance 1,000 1,000 1,000 1,000 1,000 1,000
Balance as % of Available Base 8% 7% 6% 6% 6% 6%

Avg. Interest 80 80 80 80 80

Total Interest Expense 321 287 228 169 110

Total Scheduled Principal Payments 740 740 740 740 740

LONG TERM DEBT

Revolver

PROJECTED DEBT SCHEDULES
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Closing remarks

• Financial excellence is having the 
processes in place to confidently make, on 
a timely basis, informed decisions 
regarding matters that significantly impact 
the cash-flow of your business. 

• Financial excellence is achieved through 
four steps:

1. Capturing data that impacts cash flow
2. Quantifying expected outcomes
3. Analyzing actual performance versus plans
4. Having confidence to act decisively
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